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Notices 
The International Website Development with Sitecore documentation is confidential and is only for the 
use of SUBWAY® headquarters, regional office, and approved ad agency personnel. Unauthorized use 
of the information contained herein is strictly prohibited. No part of the content of the International 
Website Development with Sitecore documentation may be copied or reproduced in any form or 
transmitted by any means without the written permission of Doctor’s Associates Inc. 

Updates, additions, and other revisions to the International Website Development with Sitecore 
documentation will be made, as necessary, to reflect changes in features, functionality, and/or 
workflow.  

SUBWAY® is a registered trademark of Doctor’s Associates Inc. ©2015 Doctor’s Associates Inc. All 
rights reserved. 
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Overview 
This manual describes the tools and procedures you need to manage a website presence that meets 
your local needs while adhering to the brand, creative, and user experience standards for SUBWAY® 
restaurants. These tools allow you to: 

 Edit existing content, such as text, images, and hyperlinks 

 Import new content, such as images and videos for Flash 

For the details of the content you can and cannot change, refer to International Website Development 
Manual. 

Sitecore features two editors: 

 The page editor allows you to edit items directly on the webpage but with limited functionality. It is 
a what-you-see-is-what-you-get (WYSIWYG) editor. 

 The content editor allows you to edit more content than the page editor, such as marquees and 
carousels. In the content editor, you choose and edit the components from a tree structure. 

Your account permissions restrict which editor you can use, either the page editor only or both. 

Important If your account gives you access to both editors, use only one of them during a session. 
Switching between the two editors during a session can cause the application to fail. 

You use an Internet browser to edit the content on your website. 

Note The preferred browser for editing your website is Google Chrome. 

All browsers, especially Internet Explorer, require special settings to use Sitecore. See 
Browser Configuration Reference from Sitecore. 

If you upgrade your browser and it no longer functions as described in this guide, try an 
earlier version or a different browser. See Browser Configuration Reference from Sitecore. 

Important To view your published content changes, use a browser different from the one with which 
you are editing content. Using the same browser for both editing and reviewing content can 
cause the application to fail. 
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Logging into the Page Editor 
Important If your account allows you access to both editors, use only one of them during a session. 

Switching between the two editors during a session can cause the application to fail. 

1. In your browser, go to cms.w.subway.com/sitecore/login. 

  

2. If the options are not showing, click Options. 

3. Click Page Editor. 

4. Select the User Interface Language. 

The default language is English. 

5. Enter your User Name and Password. 

Note If you want to change your password, see Changing Your Password, page 4. 

6. Click Login. 

The browser displays the website in the same way as it does the published website but with the 
addition of a ribbon that contains the commands you use to edit the site. 

http://cms.w.subway.com/sitecore/login
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The ribbon has two states: 

 Compressed 

 

 Expanded 

 

You toggle between the two by clicking the toggle button at the right end of the ribbon. 

The ribbon includes a set of tabs (Home, Advanced, Experience, WeBlog, and View), each of which 
displays a different set of buttons when clicked. Clicking a tab in the compressed ribbon expands the 
ribbon. 

Note The expanded ribbon always includes the Edit and the Preview buttons, no matter which 
tab is open. 

Logging off the Page Editor 
On the Home tab, click Log Off. 
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Changing Your Password 

 

1. On the login page, click Change Password. 

The Change Your Password page appears. 
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2. Enter all of the following information: 

 Your User Name, if not already entered 

 Your current Password 

 Your New Password 

 Your new password in Confirm New Password 

3. To save your new password, click Change Password; otherwise, click Cancel to keep your 
current password. 

If you clicked Change Password, the application confirms the change. 

 

4. Click Continue. 
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Using the Page Editor 
The page editor allows you to edit components directly on the webpage but with limited functionality. It 
is a what-you-see-is-what-you-get (WYSIWYG) editor. 

When you log into the page editor, the browser displays the website in the same way as it does the 
published website but with the addition of a ribbon, which contains the commands you use to edit the 
site. 

 

1. On the Experience tab, click the flag button. 

The drop-down list contains the language versions available for your country’s website. 

 

2. Click the language of the site you want to edit. 
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3. Go to the page you want to edit. 

The editor provides two navigation tools: 

 You can use the website’s menus in the same way as a typical reader does when navigating 
the published website. 

 You can use the navigation path at the bottom of the expanded ribbon. 

 

The navigation path displays the position of the currently displayed page within the hierarchy 
of the website. Base represents the website’s home page.  

To navigate to any page displayed in the navigation path, select it, and then click Go. 

To navigate to a page at the same level in the hierarchy 
as a page displayed in the navigation path, click the arrow 
to the left of the page, select the page you want, and then 
click Go. 

 

To navigate to a page at the next lower level in the 
hierarchy as a page displayed in the navigation path, click 
the arrow to the right of the page, select the page you 
want, and then click Go. 

 

4. When the browser displays the page you want to edit, click Lock on the Home tab to lock the 
page. 

The Lock button is highlighted . Locking the page prevents others from editing it but does not 

prevent you from saving it or publishing it. 

If the Lock button is disabled ( ), then the page is locked by another user. You cannot edit the 

page. 
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Each content component that you can edit is surrounded by a dashed line. 

 

5. Click in the content component you want to edit. 

When you click the component, the line surrounding it becomes solid. 

 

6. Edit the content. 

 If the content is unformatted text, simply edit the text in the component. 

 If the content is formatted text (rich text), see Editing Rich Text in the Page Editor, page 
13. 

 If the content is an image, see Editing Images in the Page Editor, page 17. 

 If the content represents a hyperlink, see Editing Hyperlinks in the Page Editor, page 20. 
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7. Click the Save changes button . 

Note You cannot preview or publish your changes without first saving them. If you forget to save 
your changes, you are prompted to do so. 

8. To see how the content looks when published, click Preview in the expanded ribbon. 

The browser displays the page as it looks when published.  

 

9. To exit preview mode, click Edit in the expanded ribbon. 

Note You can publish the page without first exiting preview mode. 

10. When finished making your changes to the page, click Publish on the Home tab. 

The Publish Item Wizard appears. 

11. To open this and other wizards at the second 
page instead of the first, select Always skip 
the first page of wizards. 

12. Click Next. 

The wizard displays the Settings page. 
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Warning If the Publishing group lists the option 
Republish - Publish Everything, do 
not select it. Selecting this option 
causes the publishing process to check 
the status (changed or not changed) of 
every item in the website. The resulting 
process can take hours to complete. 

13. Select the following in the Publishing group: 

 Smart Publish 

 Publish Subitems 

 Publish Related Items 

14. In the Publishing Languages group, select 
only the language in which the website is 
written. 

Important If the list is long, be sure to scroll 
through it completely and make sure 
that no other languages are selected. 
The wizard remembers your selection 
from the last time you published. 

 

15. Click Publish. 

The application prompts you to confirm that 
you want to publish the page. 

16. Click OK. 

The Publishing page displays the progress of 
the publishing. 
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17. The wizard informs you when the publishing 
is complete. 

18. Click Finish. 

 

19. Check the public website to confirm that the content is correct. 

 

20. After editing the content on the page and publishing your changes, unlock the page. You can use 
one or both of the following methods: 

 Click Lock on the Home tab. 

The page is unlocked. 

 On the Home tab, click My Items. 

The My Items dialog box lists the 
pages and components you locked. 

 To unlock an item, select it in the 
list, and then click Unlock.  

The item is removed from the list. 

 To unlock all items at once, click 
Unlock All.  

All items are removed from the 
list. 

 When you are finished unlocking 
items, click Close. 
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Your Lock-Save-Publish Strategy 
You need not lock, edit, save, publish, and unlock a page before repeating the process with another 
page. You can choose a strategy that is convenient for you and the set of content changes you are 
making.  

When editing content, keep the following in mind: 

 Always lock a page before editing it; otherwise, you have no guarantee that the changes you 
make will get published. Others may edit the page before you publish it. 

 If you do not save your changes and then try to preview or publish the page, the system prompts 
you to save your changes.  

 If you click No, your changes are not saved, and the page is previewed or published without 
them.  

 To cancel the preview or the publishing, click Cancel; your changes remain but are not 
saved. 

 If you attempt to navigate to another page without saving your changes, the system warns you 
that there are unsaved changes and allows you to cancel the navigation. If you continue to the 
new page anyway, your changes are lost. 

 You need not unlock a page before previewing or publishing it.  

 You can navigate to another page without unlocking the current page. 

 It is more efficient to publish from each page on which you make changes than from Base.  

If you want to wait and publish after making all your changes, keep track of the pages you change 
and make sure you publish them all. 

 You can unlock all locked pages from the My Items dialog box before logging off. 

In the event of mistakes, keeping pages locked during an editing session allows you to edit them 
again before others lock them. 

Important Locked pages remain locked between editing sessions. 

Before logging off, click My Items. Unlock all pages and components that you have finished 
editing. 
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Editing Rich Text in the Page Editor 
In the page editor, you can edit text content that is formatted. 

When you click a rich text component, a tool set 
appears just above the component. 

1. To apply a character format to a short piece of 
text, select the text, and then click one of the 
following buttons: 

 Bold  

 Italic  

 Underline  

2. To edit the content using a larger set of tools, 

click the Edit the text button . 

The rich text editor, a what-you-see-is-what-you-
get (WYSIWYG) editor, opens. For details about 
using the rich text editor, see Using the Rich 
Text Editor, page 14. 

 

3. To make a short piece of text into a hyperlink, select the text, and then click the Link button . 

The Insert a Link dialog box opens. You can link to a page 
in the website (Internal Link tab) or to a media file (Media 
Items tab). 

Select the target of the hyperlink, and then click Link. 
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4. To insert an image at the insertion point, click the Image button . 

The Insert Media Item dialog box opens, displaying the 
content tree for the media library.  

Select the media file you want, and then click Insert. 

 

5. Click the Save changes button . 

Using the Rich Text Editor 

Available in both the page editor and the content editor, the rich text editor is a what-you-see-is-what-
you-get (WYSIWYG) editor. The editor provides a large array of tools to format the text directly. The 
tools function as similar tools do in a standard word processor. 

 

Note In the tool tables that follow, do not use the tools marked with an asterisk (*). They are listed 
in these tables for the purposes of documentation only. 

The editor includes four types of tools: 

 Character formatting tools 

Select the text you want to format, and then click the tool (button). The following table lists the 
available character formatting tools. 

Tool Character Format Tool Character Format 

 
Bold  

 
(*) Superscript  

 
Italic  

 
Font color (foreground color) 



International Website Development with Sitecore 

Rev. 1.0 | 3/26/2015 ©2015 Doctor’s Associates Inc. All Rights Reserved. Page | 15 
 SUBWAY® is a registered trademark of Doctor’s Associates Inc. 

Tool Character Format Tool Character Format 

 
Underline  

 
(*) Background (fill) color, the 
color behind the selected text 

 
(*) Strikethrough   (*) Change the font 

 
(*) Subscript   Change the size of the font 

 Paragraph formatting tools 

Position the mouse cursor anywhere within the paragraph you want to format, and then click the 
tool (button). The following table lists the available paragraph formatting tools. 

Tool Paragraph Format Tool Paragraph Format 

 
Ordered (numbered) list 

 
Indent paragraph 

 
Unordered (bulleted) list 

 
Outdent paragraph 

 Apply a paragraph style 

The styles include the standard HTML styles, such as Normal, Heading 1, and 
Heading 2. 

 Insertion tools 

Place the insertion point in the text, and then click the tool (button). The following table lists the 
available items you can insert. 

Tool Insert Tool Insert 

 
Paragraph 

 
Symbol 

 
(*) Current date 

 
(*) Current time 

 
(*) Insert a horizontal rule 
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Tool Insert Tool Insert 

 
Hyperlink 

When you click the tool, the Insert a Link dialog 
box opens. You can link to a page in the website 
(Internal Link tab) or to a media file (Media Items 
tab). 

Select the target of the hyperlink, and then click 
Link. 

 

 
(*) Media file, such as an image 

When you click the tool, the Insert Media Item 
dialog box opens, displaying the content tree for 
the media library. 

Select the media file you want, and then click 
Insert. 

 

 
(*) Table 

When you click the tool, the table palette 
appears. Drag the mouse pointer across the cell 
grid you want, or click Table Wizard to open a 
wizard for creating a table. 

Once you create the table, you can use the tools 
in the table palette to format the table. 

 



International Website Development with Sitecore 

Rev. 1.0 | 3/26/2015 ©2015 Doctor’s Associates Inc. All Rights Reserved. Page | 17 
 SUBWAY® is a registered trademark of Doctor’s Associates Inc. 

 Action tools 

Click the tool (button) to do the action. The following table lists the available actions you can do. 

Tool Action Tool Action 

 
Undo the previous action. 

 
Cut the selected content to the 
clipboard. 

 
Redo the previous undone action. 

 
Copy the selected content to the 
clipboard. 

 
Paste the content on the clipboard 
at the insertion point. 

 
Find the specified text and 
optionally replace it with other text. 

 
Check the spelling of the text.  Magnify the rich text in the editor 

This setting does not affect how 
the browser displays the rich text. 

Note If you are using the rich text editor from the content editor, you can view the underlying 
HTML by clicking HTML. 

This feature is not available when using the rich text editor from the page editor. 

When you are finished editing the rich text, do one of the following: 

 To save your changes, click Accept. 

 To close the editor without saving your changes, click Reject. 

Editing Images in the Page Editor 
In the page editor, you can edit image content. 

1. After locking the page, click the image. 

A tool set appears above the image, which is surrounded by a solid line. 
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2. Edit the image.  

You can do any of the following: 

 Change the image to another image. See Changing an Image, page 18. 

 Change the alternate text for the image. See Changing the Alternate Text for an Image, 
page 20. 

 To delete the image from its placeholder, click the Remove the image button . 

The image placeholder remains. You can insert another image into it by clicking the Choose 
an image button . See Changing an Image, page 18. 

An image that also serves as a hyperlink includes a Link button  in its tool set. To change the 
target of the hyperlink, see Editing Hyperlinks in the Page Editor, page 20. 

 

3. Click the Save changes button . 

Changing an Image 

To change the image to another image: 

1. Click the Choose an image button . 

The Media Browser dialog box opens. You can either search or browse for the image you want. 
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2. To browse the images at the website, click the Browse tab. 

The dialog box displays the content structure of the media library as a tree, opened to the location 
of the current image. You can open and close the folders to navigate the tree. 

 

3. In the tree, navigate to the new image file and select it. 

 

4. To use the selected image, click OK; otherwise, click Cancel to keep the current image. 

The dialog box closes. 
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Changing the Alternate Text for an Image 

To change the alternate text (the text that displays when the reader chooses not to display graphics) for 
the image: 

1. Click the Modify image appearance button . 

The Image Properties dialog box opens.  

 

2. Enter the Alternate Text, the text that displays when a reader turns off the browser’s display of 
graphics. 

Important Do not enter or change the values in the following fields: 

 Width and Height 

 Horizontal Space and Vertical Space 

3. To save your changes, click OK; otherwise, click Cancel to keep the current alternate text. 

The dialog box closes. 

Editing Hyperlinks in the Page Editor 
A hyperlink (or link) allows a reader to navigate to another webpage or open a media file by simply 
clicking the hyperlink, which is functionally superimposed over a piece of text or an image. A 
component that also serves as a hyperlink includes a Link button  in its tool set. 
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To edit the hyperlink: 

1. Click the Link button . 

The Insert a link dialog box opens. You can point the hyperlink to three different types of targets. 

2. If the target is another page on your website, 
click Internal Link. 

The dialog box displays the content of your 
site as a tree, each position on the tree 
represents a page on your website. 

a. In the tree, select the target page of the 
hyperlink. 

b. If necessary, edit the Link 
Description.  

Note The purpose of the Link Description 
depends upon the component that 
contains the hyperlink: 

 In general, the Link Description 
is the text the browser displays as 
the link. If you leave the Link 
Description blank, then the 
browser displays the name of the 
target page, which may be 
unreadable text. 

 If the hyperlink is attached to an 
image, the browser displays no 
text. 

 

c. Although you can change Target Window, you should probably not. You likely want the 
new target to function the same way as the current one. 

d. Leave Anchor, Style Class, and Query String blank. 

e. If necessary, edit the Alternate Text.  

In general, the browser displays this text as a tooltip when the mouse hovers over the link. It 
can be blank. 
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3. If the target is a media file, such as a PDF, 
click Media Link. 

The dialog box displays the content of your 
media library as a tree. Files are contained in 
the Files folder. 

a. Navigate the tree and select the target 
file of the hyperlink. 

b. If necessary, edit the Link 
Description.  

Note The purpose of the Link Description 
depends upon the component that 
contains the hyperlink: 

 In general, the Link Description 
is the text the browser displays as 
the link. If you leave the Link 
Description blank, then the 
browser displays no text to click. 

 If the hyperlink is attached to an 
image, the browser displays no 
text. 

 

c. Although you can change Target Window, you should probably not. You likely want the 
new target to function the same way as the current one. 

d. Leave Style Class blank. 

e. If necessary, edit the Alternate Text.  

In general, the browser displays this text as a tooltip when the mouse hovers over the link. It 
can be blank. 
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4. If the target is a page outside your website, 
click External Link. 

a. If necessary, edit the Link 
Description.  

Note The purpose of the Link Description 
depends upon the component that 
contains the hyperlink: 

 In general, the Link Description 
is the text the browser displays as 
the link. If you leave the Link 
Description blank, then the 
browser displays no text to click. 

 If the hyperlink is attached to an 
image, the browser displays no 
text. 

b. Enter the URL of the target. 

 

c. Although you can change Target Window, you should probably not. You likely want the 
new target to function the same way as the current one. 

d. Leave Style Class blank. 

e. If necessary, edit the Alternate Text.  

In general, the browser displays this text as a tooltip when the mouse hovers over the link. It 
can be blank. 

5. When finished editing the fields in the Insert a link dialog box, click OK; otherwise, click Cancel 
to close the dialog without changing the hyperlink. 

6. Click the Save changes button . 
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Logging into the Content Editor 
Important If your account allows you access to both editors, use only one of them during a session. 

Switching between the two editors during a session can cause the application to fail. 

1. In your browser, go to cms.w.subway.com/sitecore/login. 

 

2. If the options are not showing, click Options. 

3. Click Content Editor. 

4. Select the User Interface Language. 

The default language is English. 

5. Enter your User Name and Password. 

Note If you want to change your password, use the same procedure as with the page editor. See 
Changing Your Password, page 4. 

6. Click Login. 

The content editor opens. See Using the Content Editor, page 26. 

http://cms.w.subway.com/sitecore/login
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Exiting the Content Editor 

Click the Sitecore logo (upper left corner), and 
then click Exit. 

The application prompts you to save any unsaved 
changes. 

 

 



International Website Development with Sitecore 

Page | 26 ©2015 Doctor’s Associates Inc. All Rights Reserved. Rev. 1.0 | 3/26/2015 
 SUBWAY® is a registered trademark of Doctor’s Associates Inc. 

Using the Content Editor 
The content editor allows you to edit more types of content — such as marquees and carousels — than 
the page editor does. The overall process is the same — navigate to, lock, edit, save, preview, publish, 
and unlock the content — except that the tools are different. 

The content editor displays the items in your website differently than the page editor does. The page 
editor displays the items as they are displayed on the website. The content editor displays the items as 
objects in a content tree.  
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After you log into the content editor: 

1. Display the language versions available for your country’s website by doing one of the following: 

 On the Versions tab, click the flag button. 

 

 Click the flag drop-down list. 

 

Both drop-down lists contain the language versions available for your country’s website. 

2. Click the language of the site you want to edit. 

3. Using the content tree, navigate to and select the item you need to edit. 

For detailed instructions on using the content tree, see Using the Content Tree, page 32. 

The Content tab displays the item as a set of fields grouped in sections. 
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You edit the item by editing the values in the fields. You show or hide the fields in a section by 
clicking the plus or the minus sign at the right end of the section header. 

If the set of sections and fields is large, you can navigate to the one 
you want by doing one of the following: 

 Using the scroll bar 

 Clicking the sections and fields navigation button to the left of the 
flag drop-down list 

Click the section or field you want to view. 

 

4. Lock the item. 

You must lock a item before you can edit it. Do one of the following: 

 On the Home tab, click Edit. 

 Click Lock and Edit in the lock notice. 
 
 

A lock icon displays to the left of the item in the content tree and the Edit button highlights  to 

indicate that the selected item is locked.  



International Website Development with Sitecore 

Rev. 1.0 | 3/26/2015 ©2015 Doctor’s Associates Inc. All Rights Reserved. Page | 29 
 SUBWAY® is a registered trademark of Doctor’s Associates Inc. 

 

A lock icon in the leftmost column of the content 
tree indicates that the item is locked either by 
you or by someone else. In the example, the 
entire Planning page is locked by a user. 

When you hover the mouse pointer over a lock 
icon, the tool tip displays the user name of the 
person who locked the item. 

 

5. Edit the item, that is, edit its fields. 

 For simple text or a title, see Editing Simple Text and Titles, page 38. 

 For rich text data, see Editing Rich Text Data in the Content Editor, page 39. 

 For an image or a video file, see Editing Images in the Content Editor, page 47. 

 For a hyperlink, see Editing Hyperlinks in the Content Editor, page 53. 

 For a marquee, see Editing Marquees, page 58. 

 For a carousel, see Editing Carousels, page 63. 

 For a sidebar, see Editing Sidebars, page 69. 

6. Click Save to save your changes. 

7. To preview your changes, click Preview on the Publish tab. 
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Warning When you publish your changes, do not click Publish > Publish Site on the Publish tab. 
Clicking Publish Site causes the publishing process to check the status (changed or not 
changed) of every item in the website. The resulting process can take hours to complete. 

8. On the Publish tab, click Publish > Publish Item to publish your changes to the item. 

This command publishes the selected item only, not the page containing the item. To publish all 
the changes you made to the page, select the page in the content tree, and then click Publish > 
Publish Item. 

The Publish Item Wizard appears. 

9. To open this and other wizards at the second 
page instead of the first, select Always skip 
the first page of wizards. 

10. Click Next. 

The wizard displays the Settings page. 

 

11. Select the following in the Publishing group: 

 Smart Publish 

 Publish Subitems 

 Publish Related Items 

12. In the Publishing Languages group, select 
only the language in which the item is 
written. 

Important If the list is long, be sure to scroll 
through it completely and make sure 
that no other languages are selected. 
The wizard remembers your selection 
from the last time you published. 

 

 

13. Click Publish. 

The application prompts you to confirm that you want to publish the item. 

14. Click OK. 
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The Publishing page displays the 
progress of the publishing. 

 

The wizard informs you when the 
publishing is complete. 

 

15. Click Finish. 

16. When finished making changes, be sure to unlock all the items you locked. Do any of the 
following: 

 Click the lock icon on the item in the content tree. 

The lock icon disappears from the item. 

 Select the item in the content tree, and then click Edit on the Home tab. 

The lock icon disappears from the item in the content tree. 

 On the Review tab, click My Items. 

The My Items dialog box lists the items you locked. The dialog box functions the same as it 
does in the page editor. See Using the Page Editor, page 6. 
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Using the Content Tree 
In the content editor, you use the content tree to navigate to and select the items you need to edit. 

Content, the root of the content tree, represents the entire 
content of your website and contains the following: 

 Base represents the home page of your website and 
contains all the webpages that make up the site. 

 Promotions contains the complex assets used on 
your website, namely, the marquees, carousels, and 
sidebars. 

 Global contains assets used by all pages on your 
website, such as cascading stylesheets and page 
footers. 

Important Do not edit the items contained in Global. 

 

Note If the tree displays sitecore as its root, you can 
change the root to Content by clearing Entire 
Tree on the View tab. 
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To open a container element in the content tree, click its + 
(plus sign). 

When a container is open, the content tree lists its contents 
below it and indented. 

To close a container, click its – (minus sign). 

While Base represents the home page of your website, the 
items inside the Base container represent the webpages to 
which a reader can navigate from the home page. 
Likewise, the items inside a page container represent the 
webpages to which the reader can navigate from that 
page. 
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The editable items on a page are contained in the page’s 
Components folder. 

 

The complex assets (marquees, carousels, and sidebars) 
are also contained in folders. 
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Each component the content tree lists for a website page is titled with a short phrase that may or may 
not be a good indication of the component as it appears on the published website. To determine which 
component is which and which component you need to edit, open another browser and navigate to the 
relevant page on the published website. In the content tree, select each component listed for that page 
and compare the content of its fields with the content you see on the published website. A positive 
comparison indicates the correct component.  

For example, the following is part of the catering landing page on the published website. 

 

The Catering FAQs section of the page contains the following pieces of content: 

 Image 

 

 Title 

 

 Text content 

 

 Hyperlink 
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After comparing the components in the content tree with the published website, you can determine that 
the following components correspond to these four pieces of content: 

 Catering FAQs-Image corresponds to the image. 

 

 CateringFAQs-Title corresponds to the title. 
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 CateringFAQs-Text corresponds to the text content. 

 

 CateringFAQsLearnMore-Link corresponds to the hyperlink. 

 

Note There are two LEARN MORE hyperlinks on the page. Due to its position on the page, you 
can be reasonably sure that the CateringFAQsLearnMore-Link is the correct one. You can 
get additional information by hovering the mouse pointer over the hyperlink in the published 
page. When you do, the browser’s status bar displays the target of the hyperlink. 

 

The target corresponds to the value of the Link field of the item CateringFAQsLearnMore-
Link. 
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Editing Simple Text and Titles 
A component that represents simple, unformatted text or a title has a field that contains plain text. 

To edit the component: 

1. In the content tree, select the component. 

2. Lock the component. 

 

 

3. Edit the unformatted text in the Text or the Title field. 

4. If the component is a title, edit its hyperlink (TitleWithLink). You can leave TitleWithLink blank, 
in which case the title has no hyperlink. 

See Editing Hyperlinks in the Content Editor, page 53. 

Note If TitleWithLink is blank, the browser displays the value of Title as the title.  

Otherwise, the browser displays Description (or Link description) from the hyperlink 
(TitleWithLink) as the title. 

5. Save the component. 

6. Publish the component. 

7. Unlock the component. 
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Editing Rich Text Data in the Content Editor 

A component that represents formatted text contains rich text 
data. Rich text is stored in the hypertext markup language 
(HTML). 

To edit the component: 

1. In the content tree, select the component. 

2. Lock the component. 

 

 

3. Edit the rich text data, using one or both of the following: 

 If you know HTML, click Edit Html to open the HTML editor. 

 

You can edit the HTML content directly in the editor. Click Validate to check that your HTML 
content is XHTML compliant. Click Fix to correct any errors. Search the Internet for guides 
on editing HTML. 
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 Otherwise, click Show Editor to open the rich text editor, a what-you-see-is-what-you-get 
(WYSIWYG) editor. 

 

The editor provides a large array of tools to format the text directly. The rich text editor 
functions the same as it does in the page editor; see Using the Rich Text Editor, page 14. 

4. Save the component. 

5. Publish the component. 

6. Unlock the component. 

Uploading Images and Videos to the Media Library 
To change an image or a video (for Flash) that your website displays to another image or video, you 
browse the images and videos already published to your website. If the image or video you want is not 
available, you need to first upload it to the media library, and then publish it to your website. 

1. In the upper right corner of the browser, click the blue button (with the down 
arrow). 
 

2. Click Media Library. 

The browser displays the content structure of the media library as a tree. 
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The Images folder contains the images you use in the 
components on a webpage. The folder contains a set of 
folders, one for each webpage in your site.  

The Images folder also contains other folders for special 
purpose images, such as the Buttons folder, which 
contains the images that are used as buttons. 

 

The Promotion Resources folder contains the images 
and videos you use in the assets, that is, the marquees, 
the carousels, and the sidebars. 
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The Marquee asset contains four containers: 

 Thumbnails, for the images you can use as cell 
fragments in a marquee 

 Mobile, for the images that a mobile phone 
displays in a marquee 

 Desktop, for the images that a desktop browser 
displays in a marquee 

 Flash, for the videos (for Flash) you can use in a 
marquee 

Each of these containers includes a folder for each 
marquee. These folders contain the images or videos for 
the corresponding marquees. 

Important If you upload an image for a marquee, be sure to 
upload a thumbnail version, a mobile version, and 
a desktop version. The marquee needs all three 
versions to function correctly for all readers. 

 

The Carousel asset includes a folder for each carousel. 
These folders contain the images for the corresponding 
carousel slides. 
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3. In the media library tree, navigate to and select the 
folder in which you want to place the image or video. 

 

The Folder tab of the media library displays the images or videos already in the selected folder. 

 

4. Click Upload Files. 

The standard Open dialog box opens. 
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5. Navigate to and select the image or video file you want. You can select more than one. 

6. Click Open. 

The media library displays the progress of the upload. 

 

To cancel the upload, click Cancel. You are prompted to confirm the cancellation. 

During the upload, you can enter the Alternate Text (the text that displays when the reader 
chooses not to display graphics); however, you can enter the alternate text later. 

As each upload finishes, the progress bar changes to a check mark. 

 

When the last upload finishes, the progress dialog box closes. 
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If you did not enter the alternate text in the 
progress dialog box, the media library displays the 
uploaded image or video in the Folder tab with a 
warning.  

 

7. Click the uploaded image or video. 

The Content tab displays the fields for the image or video. Any fields marked in red are required. 
In this case, Alt (alternate text) is required. 

 

8. Lock the image or video. 

9. Complete any required fields (marked in red). 

Important Do not change any values that are determined from the uploaded media file itself, such as 
Width or Height.  

10. Click Save to save the fields. 

The image or video is now in the database, but it is not available for use on your website. You 
need to publish it first. 

11. With the image or video selected, publish it by clicking Publish > Publish Item on the Publish 
tab. 

12. Unlock the image or video. 

13. When finished uploading media, click the blue button (with the down arrow) in 
the upper right corner of the browser. 

14. Click Content Editor. 

The media library closes.  

Organizing Image and Video Files in the Media Library 

As you upload your image and video files to the media library, organize them into folders to make it 
easier for other users to find and use them. 

To add an empty folder to a folder in the media library: 

1. In the media library tree, navigate to and select the folder in which you want to create an empty 
folder. 

2. In the Folder tab, click New Folder. 
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A dialog box opens for you to provide the name of the folder. 

 

3. Enter the name you want for the folder, and then click OK. 

The new, empty folder is created inside the selected folder. 

 

Important Create your folders at the lower levels of the 
existing content structure of the media library, 
not at the higher levels. It is important to 
maintain the general structure at the higher 
levels of the media library.  

In the example here, the videos for the 
marquee used on the Home page of the 
Canadian website are stored within a Canada 
folder inside the Home folder. The existing 
page structure (MenuNutrition, Breakfast, 
Catering, Home, and Promotions) is 
maintained. 
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Editing Images in the Content Editor 
A component that represents an image has a field that contains the path to the image file on the 
website. If the component also contains a Link field, edit it as you would any hyperlink; see Editing 
Hyperlinks in the Content Editor, page 53. 

 

In the Image field, you can do any of the following: 

 Change the image to another image. See Changing an Image, page 48. 

 Change the alternate text (the text that displays when the reader chooses not to display graphics) 
for the image. See Changing the Alternate Text for an Image, page 50. 

 Delete the image. See Deleting an Image, page 50. 
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Changing an Image 

To change the image to another image: 

1. If necessary, upload the new image to the media library, and then publish it to your website. 

See Uploading Images and Videos to the Media Library, page 40. 

2. In the Image field, click Browse. 

The Media Browser dialog box opens. You can either search or browse for the image you want. 

 

3. To browse the images at the website, click the Browse tab. 

The dialog box displays the content structure of the media library as a tree, opened to the location 
of the current image. You can open and close the folders to navigate the tree. 
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4. In the tree, navigate to the new image file and select it. 

 

5. To use the selected image, click OK; otherwise, click Cancel to keep the current image. 

The dialog box closes. 
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Changing the Alternate Text for an Image 

To change the alternate text (the text that displays when the reader chooses not to display graphics) for 
the image: 

1. In the Image field, click Properties. 

The Image Properties dialog box opens.  

 

2. Enter the Alternate Text, the text that displays when a reader turns off the browser’s display of 
graphics. 

Important Do not enter or change the values in the following fields: 

 Width and Height 

 Horizontal Space and Vertical Space 

3. To save your changes, click OK; otherwise, click Cancel to keep the current alternate text. 

The dialog box closes. 

Deleting an Image 

To delete the image, click Clear in the Image field. 
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Adding or Changing a Video for Flash 

Some assets and components have a field that specifies a 
video (for Flash) that the asset or component displays. 

If the field is blank, you can add a video to the asset or 
component. 

If the field lists a video, you can change it to another video. 

 

To add or change a video: 

1. If necessary, upload the new video to the media library, and then publish it to your website. 

See Uploading Images and Videos to the Media Library, page 40. 

2. In the content tree, select the asset or component that contains the video. 

3. Lock the item. 

4. Scroll to the field that specifies the video. 

5. Click Open file. 

The Media Browser dialog box opens. You can either 
search or browse for the video you want. 

 

6. To browse the videos at the website, click the Browse tab. 

The dialog box displays the content structure of the media library as a tree. You can open and 
close the folders to navigate the tree. 
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7. In the tree, navigate to the new video file and select it. 

 

8. To use the selected video, click OK; otherwise, click Cancel. 

The dialog box closes. The field displays the path to the new video. 

 

9. To watch the video, click View file. 
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The browser opens a new window or tab and plays the video in it. Close the window or tab. 

10. To remove the video from the item, click Clear. 

11. Save the item. 

12. Publish the item. 

13. Unlock the item. 

Editing Hyperlinks in the Content Editor 
A hyperlink (or link) allows a reader to navigate to another webpage or open a media file by simply 
clicking the hyperlink, which is functionally superimposed over a piece of text, an image, or a video (for 
Flash). You can edit a hyperlink to specify its target, which can be one of the following: 

 Another page in your website; see Targeting a Page within Your Website, page 53 

 A page in a website outside your website; see Targeting a Page outside Your Website, page 55 

 A media file, such as a PDF file; see Targeting a Media File, page 56 

Targeting a Page within Your Website 

Typically, the target of the hyperlink is a page in your website. 

1. In the content tree, select the item that contains the hyperlink. 

Note Typically, a component that has a link, such as a title, a simple link, or an image, is 
contained in the Components folder for the webpage that displays it, that is, under Base in 
the content tree. 

To edit a link that is part of a marquee or a carousel, select the marquee or carousel under 
Promotions in the content tree. 

2. Lock the item. 

3. Open the field group containing the hyperlink, that is, the field with a name that includes the string 
“Link.” 

 

4. Click Insert Link. 
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5. In the Sitecore Items list, select the new target of the link. 

6. If necessary, edit the Description.  

Note The purpose of the Description depends upon the item that contains the hyperlink: 

 In general, the Description is the text the browser displays as the link. If you leave the 
Description blank, then the browser displays the item name of the target page, which 
may be unreadable text. 

 If the hyperlink is attached to an image, the browser displays no text. 

 If the hyperlink is attached to a carousel slide, the Description is the text the slide 
displays below the image. If you leave the Description blank, then the slide displays 
no text. 

 If the hyperlink is attached to a marquee cell, the marquee displays the Description as 
a tooltip when the mouse hovers over the link. If you leave the Description blank, the 
marquee displays no tooltip. 

7. If necessary, edit the Alternate text.  

In general, the browser displays this text as a tooltip when the mouse hovers over the link. It can 
be blank. 

8. Leave Style class and Query string blank. 

You cannot select the Target. 

9. Click Insert Link. 

10. Save the item. 

11. To check that the target is correct, click Follow. 

The content editor displays the target item. In the Navigate tab, click Back to display the item you 
are editing. 
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12. Publish the item. 

13. Unlock the item. 

Targeting a Page outside Your Website 

You can change the target of the hyperlink to point to a page that is outside your website. 

1. In the content tree, select the item that contains the hyperlink. 

Note Typically, a component that has a link, such as a title, a simple link, or an image, is 
contained in the Components folder for the webpage that displays it, that is, under Base in 
the content tree. 

To edit a link that is part of a marquee or a carousel, select the marquee or carousel under 
Promotions in the content tree. 

2. Lock the item. 

3. Open the field group containing the hyperlink, that is, the field with a name that includes the string 
“Link.” 

 

4. Click Insert External Link. 

 

5. If necessary, edit the Link description.  

Note The purpose of the Link description depends upon the item that contains the hyperlink: 

 In general, the Link description is the text the browser displays as the link. If you 
leave the Link description blank, then the browser displays no text to click. 

 If the hyperlink is attached to an image, the browser displays no text. 



International Website Development with Sitecore 

Page | 56 ©2015 Doctor’s Associates Inc. All Rights Reserved. Rev. 1.0 | 3/26/2015 
 SUBWAY® is a registered trademark of Doctor’s Associates Inc. 

 If the hyperlink is attached to a carousel slide, the Link description is the text the 
slide displays below the image. If you leave the Link description blank, then the slide 
displays no text. 

 If the hyperlink is attached to a marquee cell, the marquee displays the Link 
description as a tooltip when the mouse hovers over the link. If you leave the Link 
description blank, the marquee displays no tooltip. 

6. Enter the URL of the target. 

7. Select the Target window. 

 Active browser displays the target in the current browser window. 

 New browser displays the target in a new browser window. 

8. If necessary, edit the Alternate text.  

In general, the browser displays this text as a tooltip when the mouse hovers over the link. It can 
be blank. 

9. Leave Style class blank. 

10. Click OK. 

11. Save the item. 

12. To check that the target is correct, click Follow. 

The browser opens a new window or tab to display the target. Close the window or tab displaying 
the target. 

13. Publish the item. 

14. Unlock the item. 

Targeting a Media File 

You can change the target of the hyperlink to point to a media file, such as a PDF file. 

1. In the content tree, select the item that contains the hyperlink. 

Note Typically, a component that has a link, such as a title, a simple link, or an image, is 
contained in the Components folder for the webpage that displays it, that is, under Base in 
the content tree. 

To edit a link that is part of a marquee or a carousel, select the marquee or carousel under 
Promotions in the content tree. 

2. Lock the item. 

3. Open the field group containing the hyperlink, that is, the field with a name that includes the string 
“Link.” 
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4. Click Insert Media Link. 

 

5. In the media library tree, select the target file. 

6. If necessary, edit the Link description.  

Note The purpose of the Link description depends upon the item that contains the hyperlink: 

 In general, the Link description is the text the browser displays as the link. If you 
leave the Link description blank, then the browser displays no text to click. 

 If the hyperlink is attached to an image, the browser displays no text. 

 If the hyperlink is attached to a carousel slide, the Link description is the text the 
slide displays below the image. If you leave the Link description blank, then the slide 
displays no text. 

 If the hyperlink is attached to a marquee cell, the marquee displays the Link 
description as a tooltip when the mouse hovers over the link. If you leave the Link 
description blank, the marquee displays no tooltip. 

7. Select the Target window. 

 Active browser displays the target in the current browser window. 

 New browser displays the target in a new browser window. 
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8. If necessary, edit the Alternate text.  

In general, the browser displays this text as a tooltip when the mouse hovers over the link. It can 
be blank. 

9. Leave Style class blank. 

10. Click OK. 

11. Save the item. 

12. To check that the target is correct, click Follow. 

The content editor displays the target in the media library. In the Navigate tab, click Back to 
display the item you are editing. 

13. Publish the item. 

14. Unlock the item. 

Editing Marquees 
Located just below the store-country count, a marquee is an area on a webpage where you can 
communicate new promotions, sponsorships, events, and offers.  
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Functionally, the marquee displays a group of 
images or videos (for Flash) sequentially at 
regular intervals, and then repeats the sequence. 
For example, the home page marquee displays 
the sequence shown here.  

At any time, a reader can navigate and view any 
image or video by clicking its related thumbnail on 
the left side of the marquee. 

Typically, each image or video is a hyperlink to 
another page on the website. 

 

 

 

 

Structurally, a marquee is an ordered set of cells, each of which contains the following content data: 

 Marquee Cell 

 Hyperlink 

 Duration  

 Marquee Cell Content 

 Mobile (585 x 305 image to display on mobile phones) 

 Desktop (1000 x 300 image to display in desktop browsers) 

 Flash Video 

 Marquee Cell Fragment (thumbnail) 

 Fragment Image 

 Fragment Text 

To edit a marquee: 

1. If necessary, upload the images and videos for the marquee to the media library.  

See Uploading Images and Videos to the Media Library, page 40. 

2. In the content tree of the content editor, open the marquee. 

The path is Content > Promotions > Base > Marquees > <webpage name>. 
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3. For each cell you want to edit: 

a. Select the cell in the content tree. 

 

b. Lock the cell. 

 

c. Open Marquee Cell. 

 

d. Edit any of the following: 

 Hyperlink, the webpage or media file the browser displays when a reader clicks the 
cell 

See Editing Hyperlinks in the Content Editor, page 53. 

 Duration - (In seconds), the length of time the marquee displays the content of a cell 
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e. Open Marquee Cell Content. 

The Marquee Cell Content field specifies the media content the cell displays. 

 

f. Edit any of the following: 

 Mobile, the 585 x 305 image to display on mobile phones 

 Desktop, the 1000 x 300 image to display in desktop browsers 

You can replace the images with other images and change the alternate texts for the 
images. See Editing Images in the Content Editor, page 39. 

 Flash Video - For use in Desktop-sized screens, the video to display in desktop 
browsers 

Click Open file to add a video to the cell. See Adding or Changing a Video for 
Flash, page 51. 

Important Whether you add a video to a cell or not, always specify a mobile and a desktop image. 
Mobile phones and some tablet devices cannot display videos for Flash. 
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g. Open Marquee Cell Fragment. 

The Marquee Cell Fragment field specifies the image and text of the navigational thumbnail 
for the cell. 

 

h. Edit any of the following: 

 Fragment Image, the 70 x 60 image for the thumbnail 

You can replace the image with another image and change the alternate text for the 
image. See Editing Images in the Content Editor, page 39. 

 Fragment Text, the text for the thumbnail 

i. Save the cell. 

j. Publish the cell. 

k. Unlock the cell. 
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Editing Carousels 

Located in the secondary promotional unit, a carousel is 
another area on a webpage where you can highlight additional 
marketing promotions, new product offerings, partnerships, and 
offers. 

A carousel contains a sequence of slides, each of which 
contains an image. The carousel can display one or more 
slides together in a slide page. After a fixed interval of time, the 
carousel displays the next page of slides. For example, the 
carousel on the catering webpage contains the following slides 
in pages 1 and 2 (one slide per page). 

     

When the carousel reaches the last page of slides in the sequence, it displays the content of the 
previous page and then continues to the first page, from which it repeats the sequence. Unlike a 
marquee, a carousel cycles back and forth among its pages, rather than in one direction.  

A reader can navigate and view any page of slides by clicking its corresponding dot at the bottom of the 
carousel. The reader can also navigate back and forth among the pages by clicking the arrows at the 
left and right sides of the carousel. Typically, each slide is a hyperlink to another page on the website. 

Each slide contains the following content data: 

 Image Cell (slide) 

 Image 

 Link (hyperlink) 

Editing a carousel involves two tasks, both of which are optional. 

 Editing the Slides in a Carousel, page 63 

 Configuring a Carousel, page 65 

Editing the Slides in a Carousel 

You can edit the images and the hyperlinks of the slides in a carousel. After you edit the slides, it is not 
necessary to reconfigure the carousel where it is used on the website. 

To edit the slides in a carousel: 

1. If necessary, upload the images for the carousel to the media library. 

See Uploading Images and Videos to the Media Library, page 40. 

2. In the content tree of the content editor, open the carousel. 

The path is Content > Promotions > Base > Carousels. 
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3. For each slide that you want to edit: 

a. Select the slide in the content tree. 

 

b. Lock the slide. 

c. Open Image Cell. 

 

d. Edit any of the following: 

 Image 

You can replace the image with another image and change the alternate text for the 
image. See Editing Images in the Content Editor, page 39. 

 Link (hyperlink), the webpage or media file the browser displays when a reader clicks 
the slide 

See Editing Hyperlinks in the Content Editor, page 53. 

Note The alternate text for the image is not the text the carousel displays below the slide. You set 
the display text in the description of the hyperlink. 
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e. Save the slide. 

f. Publish the slide. 

g. Unlock the slide. 

Configuring a Carousel 

The configuration of a carousel is the subset of slides that the carousel displays, the look of the 
carousel, and the rate at which the carousel displays its slides when a reader views the carousel on a 
page of the website. You configure the carousel on the webpage where it is used. You can configure a 
carousel without editing its slides. 

To configure a carousel: 

1. In the content tree, open the page that contains the carousel you want to configure. 

The path is Content > Base > … > <webpage name>. 

2. Open the Components folder for the page. 

3. Select Carousel. 

 

4. Lock the Carousel. 

5. Open Carousel Promotion. 
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The field displays two lists. All lists the available carousels. Selected lists the slides it shows 
when a reader views the page on the website. 

 

6. To see its slides, open the carousel you want to configure. 
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7. If necessary, edit the Selected list of slides. 

 To add a slide to the list, select the slide in the All list and click the right arrow . 

 To remove a slide from the list, select the slide in the Selected list and click the left arrow 
. 

 To move a slide within the Selected list, select the slide and click the up arrow  or the 
down arrow  as often as necessary to obtain the order you want. 

Note You need not include all the slides from the All list. 

You can include slides from any of the carousels; however, it may not be wise to include 
them. The slides in the other carousels are likely not related (in content nor in size) to the 
slides in the carousel you are configuring. 

8. If necessary, edit the Title. You can leave it blank. 

The carousel displays the value of the Title in the upper left corner. 

 

9. Open Carousel Options. 

 

10. Edit any of the options as needed. 

Note These options affect the look and behavior of the carousel. Be sure you understand the 
effects of your changes. 

Changes to some options have no effect on the behavior of the carousel. For example, you 
cannot convert a horizontal carousel to a vertical one by selecting Vertical Carousel. 

The following table lists the options and their definitions. 
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Carousel Option Definition 

Slides Per Page Desktop Number of slides the carousel displays on each slide page, when 
viewed from a desktop browser 

Slides Per Page Tablet Number of slides the carousel displays on each slide page, when 
viewed from a tablet device 

Slides Per Page Mobile Number of slides the carousel displays on each slide page, when 
viewed from a mobile phone 

Auto Scroll When checked, the carousel changes slide pages automatically after 
a time interval equal to Auto Scroll Interval; otherwise, the carousel 
changes slide pages only as a reader changes the pages manually 

Auto Scroll Interval Length of time (in milliseconds) the carousel displays a slide page 
before changing to the next page 

Show Dots When checked, the carousel displays the dots, one for each slide 
page, a reader can use to navigate the pages of the carousel 

Show Border When checked, the carousel displays a border 

Center Text When checked, the text below each slide is centered; otherwise, the 
text is left-aligned 

Vertical Carousel When checked, the carousel changes slide pages by scrolling 
vertically; otherwise, the carousel changes pages by scrolling 
horizontally 

Vertical Count Number of slides the carousel displays on each slide page, when 
Vertical Carousel is checked 

Max Width Maximum width (in pixels) allowed to the carousel when a reader 
changes the size of the browser window  

Background Color Color (hexadecimal RGB) the carousel displays behind the slides; the 
choices are: 

 None; select the first (but empty) item in 
the drop-down list 

 EBEBE2 (off white) 

 00543D (dark green) 

11. Save the carousel. 

12. Publish the carousel. 

13. Unlock the carousel. 
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Editing Sidebars 
Located at the right edge of the browser window, a sidebar provides a quickly 
accessible hyperlink to a particular page, such as registration for news and offers.  

A reader opens the sidebar by clicking its tab. When the sidebar is open, the reader 
can click it to follow the hyperlink, or click the tab or X to close it. 

 

You cannot edit the content of a sidebar, but you can specify the webpages on which the sidebar 
appears. 

A sidebar contains the following content data: 

 Title 

 Image (600 x 360 image to display in desktop browsers) 

 Mobile Image (300 x 180 image to display on mobile phones) 

 Link (hyperlink) 

 Tab Image (34 x 192 image to display in the tab) 

To show or hide a sidebar on a webpage: 

1. In the content tree, select the page. 

The path is Content > Base > … > <webpage name> 
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2. Lock the page. 

3. Open Promotions. 

 

4. Do one of the following: 

 To show a sidebar on the page, select the Sidebar you want. 

 To hide the sidebar on the page, select the empty Sidebar. 

The empty sidebar is the first (but empty) item in the drop-down list. 

5. Save the page. 

6. Publish the page. 

7. Unlock the page. 

The live webpage displays the sidebar. 
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